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1 INTRODUCCIÓN 

1.1 OBJETO DEL DOCUMENTO. 

El objeto de este Informe se refiere a los aspectos relativos al diseño del módulo de salidas 

gráficas y a las normas de edición de las Cartas Geológicas a escala 1:250.000 de la República 

Argentina. 

El proceso de obtención de las Cartas Geológicas 1:250.000 se llevará a cabo mediante la 

representación, conforme a la simbología establecida en función de los contenidos temáticos, 

de geometrías de las entidades geográficas almacenadas de forma estructurada en las 

geodatabases del sistema de información geográfica del SEGEMAR. 

La finalidad general de este documento es establecer las bases para conseguir la unificación 

de producción cartográfica, para conseguir un producto homogéneo en apariencia y calidad, 

estableciendo una serie de normas para la edición del mapa en su conjunto, y cada uno de los 

elementos que lo componen, que permitan mejorar los procesos de automatización de la 

edición y el control de calidad del resultado final. 

1.2 ALCANCE. 

El presente documento titulado “Diseño del módulo de salidas gráficas de la carta Geológica” 

forma parte del Contrato entre SADIM, S.A. e Instituto de Recursos Naturales y Ordenación 

del Territorio (INDUROT) para los servicios de Asistencia Técnica para EL DISEÑO, LA 

METODOLOGÍA DE EJECUCIÓN Y LA SUPERVISIÓN DEL RELEVAMIENTO SISTEMÁTICO DE 

INFORMACIÓN GEOAMBIENTAL, Y PARA EL DISEÑO Y PUESTA EN FUNCIONAMIENTO DE UN 

SISTEMA DE INFORMACIÓN GEOAMBIENTAL. 

Este informe persigue la actualización de los trabajos desarrollados en la Subactividad 3.3 de 

Diseño y desarrollo de un subsistema específico para la producción de cartografía digital en 
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plataforma ArcGIS integrado al SIGAM, respecto de la Subactividad 3.3.d, Propuesta y 

discusión módulo de salidas gráficas. En concreto se modifica el documento anterior, de 

noviembre de 2015, para adaptar los contenidos al nuevo modelo de datos y a las peticiones 

de cambios propuestas desde SEGEMAR. 

1.3 CONTENIDO DEL DOCUMENTO. 

Los contenidos del documento se estructuran conforme a los diferentes componentes o 

elementos que podrán ser incluidos en el layout, o página virtual, del mxd de cada hoja para 

conformar la salida gráfica de la Carta Geológica 1:250.000 diseñada para su impresión. Los 

principales aspectos tratados en el presente documento son: 

1. Especificaciones generales: 

Nomenclatura, tamaño y distribución de las hojas. 

2. Especificaciones del modelo de composición de hoja, incluyendo: 

Organización de los elementos de la composición. 

Mapa geológico. 

Esquemas auxiliares. 

Referencias. 

Perfiles transversales y columnares. 

Otros elementos de la carta. 

3. Denominación y características de los elementos de la composición. 

4. Dimensiones de las hojas de la serie cartográfica. 
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2 ESPECIFICACIONES GENERALES. 

La Ley No 24.224, de Reordenamiento Minero, en su Capítulo I, de las Cartas Geológicas de la 

República Argentina, dispuso la necesidad de efectuar el relevamiento geológico regular y 

sistemático del territorio continental, insular, plataforma submarina y Territorio Antártico de 

la República Argentina, en diferentes escalas (artículo 1). 

Para dar respuesta a este mandato la Dirección de Geología Regional, perteneciente al 

Instituto de Geología y Recursos Minerales (IGRM) tiene la responsabilidad de implementar el 

Programa Nacional de Cartas Geológicas a escalas 1:250.000 y 1:100.000.  

El ámbito geográfico del Proyecto es todo el territorio nacional distribuido por hojas a escala 

1:250.000 y 1:100.000. Con el objetivo de completar la primera versión de cartas geológicas 

de todo el territorio se ha seleccionado la escala 1:250.000. 

A escala 1:250.000 el territorio argentino, a excepción de la Antártida, queda dividido en 247 

hojas. La cantidad de Cartas Geológicas será ligeramente inferior por realizarse de forma 

conjunta hojas de escasa cobertura territorial. A escala 1:100.000 el número de hojas es de 

1872, si bien, como en el caso de la escala 1:250.000 esta cantidad no equivale al número de 

cartas finales. 

El ámbito temático se extenderá a la cartografía geológica que deberá llevar como referencia 

y soporte la altimetría y la planimetría. La primera resulta fundamental para la correcta 

interpretación de la información geológica plasmada en las hojas, mientras que la segunda 

resulta ser clave para la ubicación en campo. 

 

Para la confección de las cartas Geológicas se adoptarán los parámetros generales 

establecidos por el Instituto Geográfico Nacional para la edición de las Cartas Topográficas 
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1:250.000 y 1: 100.000., escalas de referencia para el Programa Nacional de Cartas Geológicas 

desarrollado por el SEGEMAR. 

2.1 SISTEMA DE REFERENCIA Y PROYECCIÓN CARTOGRÁFICA. 

El Marco de Referencia Geodésico de las Cartas Geológicas será el POSGAR 07, adoptado por 

disposición del Director del Instituto Geográfico Nacional el 15 de mayo de 2009 como el 

nuevo Marco de Referencia Geodésico Nacional, reemplazando al hasta entonces vigente 

POSGAR 94. 

El sistema de proyección es la proyección GAUSS-KRÜGER, empleado por el Instituto 

Geográfico Nacional para la confección de las cartas topográficas nacionales. En esta 

proyección se considera a la Tierra como una esfera tangente a un cilindro según un 

meridiano, en el cuál, los puntos de tangencia no sufren deformación alguna. 

 

 

Figura 1. Proyección GAUSS-KRÜGER 
Fuente: http://www.ign.gob.ar/NuestrasActividades/ProduccionCartografica/Introduccion. 

 

La representación del territorio argentino (sector continental e Islas Malvinas) mediante la 

proyección conforme de Gauss-Krüger se considera al territorio nacional dividido en 7 fajas 

meridianas de 3° en longitud  y 34° de latitud, numeradas correlativamente del 1 al 7 

correlativamente de Oeste a Este, correspondiéndole a cada faja, en ese orden, el meridiano 

central Oeste de Greenwich (Tabla 1; Figura 2). A partir de este meridiano central, hacia el 

Este y el Oeste, se ha limitado cada zona o faja por dos meridianos límites de faja, que distan 

del central a 1° 30´ (IGNRA, 2010). 
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Tabla 1. Proyección conforme GAUSS-KRÜGER fajas meridianas 

Faja 
meridiana  

Meridiano central 
de faja  

Meridianos  
límites de faja  

1  -72º  -73° 30´ -70° 30´ 
2  -69º  -70° 30´ -67° 30´ 
3  -66º  -67° 30´ -64° 30´ 
4  -63º  -64° 30´ -61° 30´ 
5  -60º  -61° 30´ -58° 30´ 
6  -57º  -58° 30´ -55° 30´ 
7  -54º  -55° 30´ -52° 30´ 

 

El origen de las ordenadas X es el Polo Sur y son positivas hacia el Ecuador. Su valor expresa la 

distancia en metros del polo al punto, según la dirección del meridiano central de la faja a la 

que pertenece el punto. 

El origen de las abscisas Y es el meridiano central de cada faja, al que se le asigna un valor 

convencional de 500.000m. El valor de la Y, tiene un concepto diferente al de la X. El primer 

número indica la faja, y los subsiguientes, si el punto está al Oeste del meridiano central, sobre 

el meridiano o al Este del mismo. Ejemplo (IGNRA, 2010): 

2.485.000: el punto se sitúa en la faja 2, a 15 000 m al Oeste del meridiano central de la 

faja (69°). 

2.500.000: el punto se sitúa en la faja 2 sobre el meridiano central de la faja. 

2.550.000: el punto se sitúa en la faja 2, a 50 000 m al Este del meridiano central de la 

faja (69°). 
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Figura 2. Proyección conforme GAUSS-KRÜGER fajas meridianas 
Fuente: IGNAR, 2010. 

 



 

Página 15 de 73   

2.2 DIVISIÓN Y NOMENCLATURA ORDINARIA DE LAS HOJAS DE LAS CARTAS GEOLÓGICAS. 

Como norma general las Cartas Geológicas deberán seguir la distribución, dimensiones y 

nomenclatura de la grilla de las Cartas Topográficas a su escala correspondiente. 

El sistema cartográfico de la República Argentina contempla la elaboración de varias series 

cartográficas del Mapa Topográfico Nacional, elaboradas por el IGN a diferentes escalas 

comprendidas entre 1:500.000 y 1:25.000. Las escalas de referencia para el Programa Nacional 

de Cartas Geológicas son 1:250.000 y 1: 100.000. 

Para cada escala la carta topográfica está dimensionada, de manera tal que su tamaño no 

resulte incómodo para los usuarios, al mismo tiempo, que al compilar una a escala menor, el 

número de las cartas que la componen resulte un mínimo y en estas queden enteras a una 

escala menor. 

 

 

Figura 3. División de la hoja 1:500.000 3563 en hojas 1:250.000 y nomenclatura de las mismas 
Fuente: Elaborado a partir de IGNAR, 2010. 

Según las determinaciones del IGN, las hojas a escala 1: 250.000 tienen 1° 30’ minutos de 

longitud por 1° en latitud, comprendiendo, cada una de ellas, una superficie igual a la cuarta 

parte de la superficie de la carta 1:500.000. 

-63º -64º30' -61º30' 
34º 

35º 

36º 

3563-I 3563-II

3563-III 3563-IV
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La nomenclatura (característica de la hoja ) de las hojas 1:250.000 está formada por los 4 

dígitos de una hoja 1:500.0001 de la que forma parte, y a continuación separada por un guión, 

el número romano que le corresponde por el orden que ocupa dentro de aquella establecido 

según el sentido de la escritura corriente (Figura 4). 

 

Figura 4. Interpretación de la nomenclatura de las hojas 1:250.000. 

 

 

Figura 5. División de la hoja 1:500.000 3563 en hojas 1:100.000. 
Fuente: Elaborado a partir de IGNAR, 2010. 

Las hojas a escala 1: 100.000 tienen 30’ minutos de longitud por 20’ minutos de latitud. Cada 

hoja 1:500.000 se divide en 36 cartas a escala 1:100.000. 

                                                      
1 Las hojas a escala 1: 500.000 tienen 3° grados de longitud por 2° grados de latitud. Están limitados por el norte 
y por el sur por paralelos pares y como meridiano central, el de la faja a la cual pertenece. La nomenclatura o 
característica de la hoja, se forma por cuatro números de los cuales, los dos primeros indican el valor del paralelo 
central de la hoja y los dos siguientes el de su meridiano central, que es el de faja. Por ejemplo: 3563, indica el 
paralelo de 35° latitud Sur y el meridiano de 63° longitud Oeste. 

3563-I

Nomenclatura
hoja 1:500.000

Cuarto hoja 
1:250.000

Paralelo central de
la hoja 1:500.000

Meridiano central de
la hoja 1:500.000

-63º -64º30' -61º30' 

3563-I 3563-II

3563-III 3563-IV

34º 

35º 

36º 
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La nomenclatura de estas hojas 1:100.000 está formada por la de la hoja 1:500.000 de la que 

forma parte, y a continuación separada por un guion, el número de orden (1-36) que le 

corresponde por el lugar que ocupa según el sentido de la escritura corriente (Figura 5). 

Por tanto, la superficie de cada hoja de la Carta a escala 1:250.000 comprende un total de 9 

hojas escala 1:100.000 aunque no hay una relación directa entre las denominaciones de las 

hojas de ambas escalas. 

Siguiendo la grilla del Instituto Geográfico Nacional a escala 1:250.000 el territorio argentino, 

a excepción de la Antártida, queda dividido en 229 hojas (Tabla 2 y Figura 6), mientras que a 

escala 1:100.000 el número de hojas asciende a 1.898. 

Tabla 2. Distribución de las hojas de la Carta topográfica de la República Argentina a diferentes escalas. 

Escala 

Dimensiones de la 
hoja 

Cantidad de 
hojas que 

integran una a 
escala  

1:500 000 

Forma de 
identificar las 

hojas 

Cantidad 
aproximada de 

hojas que integran 
la república en latitud en 

longitud 

1: 500 000  2° 00´ 3° 00´ - 
paralelo y 
meridiano 
centrales 

124 (1) 

1: 250 000  1° 00´ 1° 30´ 4  I al IV 229 (1)(2)(3) 

1: 100 000  0° 20´ 0° 30´ 36  1 al 36 1.898 (1)(2) 

(1) Los apéndices que integran hojas en territorio argentino son considerados como hojas independientes a los 
efectos de su cómputo. 

 (2) Excepto Antártida Argentina e Islas del Atlántico Sur, excluidas las Islas Malvinas.  
(3) El número de hojas se corresponde con el de entidades geográficas de la capa ha sido calculado a partir de 

las capas en formato shp Cobertura Hojas Escala 1:250.000 obtenida de http://www.ign.gob.ar/sig 
Fuente: Elaborado a partir de IGNAR, 2010. 

 



 

Página 18 de 73   

 

 

Figura 6. División y nomenclatura de las hojas de la Carta Topográfica 1:250.000. 
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2.3 HOJAS EXTENDIDAS. 

2.3.1 EXTENSIÓN DE LA SUPERFICIE DE UNA HOJA. 

Siguiendo la grilla del Instituto Geográfico Nacional, en la Carta Geológica 1:250.000 el 

territorio argentino, a excepción de la Antártida, está dividido en 229 hojas completas a las 

que hay que añadir 20 apéndices que cubren muy poca extensión del territorio peninsular o 

insular (ver apartado 2.2). 

Para la elaboración de las Cartas Geológicas 1:250.000, cada uno de los 20 apéndices será 

incluido en la hoja adyacente, generándose un nuevo marco de hoja cuya extensión abarcará 

el territorio de la hoja completa y del apéndice, conformando una hoja extendida que será 

tratada como una única unidad de cartografía y edición. 

Con objeto de normalizar la generación de estas hojas especiales y mantener la coherencia 

con la división en hojas de series mayor escalas, la ampliación del marco de la hoja extendido 

se apoyará en la grilla de la Carta topográfica 1:100.000. La extensión de los marcos deberá 

abarcar las dimensiones de una hoja 1:100.000 completa. Se contemplan dos supuestos 

(Figura 7): 

Ampliación de la extensión en latitud: En los casos en los que la hoja de menor 

superficie se extienda a lo largo de un paralelo se genera un nuevo marco de hoja 

que abarque el territorio de la hoja completa al que se añadirán 20’ por el norte o 

por el sur, según el caso. 

Ampliación de la extensión en longitud: En los casos en los que la hoja de menor 

superficie se extienda a lo largo de un meridiano se genera un nuevo marco de hoja 

que abarque el territorio de la hoja completa al que se añadirán 30’ por el este o 

por el oeste, según el caso. 
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Figura 7.Esquema de la extensión  
en latitud (izquierda) y longitud (arriba)  

del marco de las hojas de la  
Carta Geológica 1:250.000  

 

La extensión geográfica máxima de las hojas será de 12 hojas 1:100.000 (3x4 ó 4x3, según la 

modificación afecte a la latitud o la longitud, respectivamente) lo que equivale a unas 

dimensiones máximas de las hojas 1:250.000 de 1° 20´, en latitud, y 1° 60´, en longitud. 

Por lo general, cualquier ampliación que supere estas dimensiones deberá ser tratada como 

dos unidades de representación independientes, aplicándose las determinaciones 

establecidas para la división y nomenclatura ordina (apartado 2.2). 

No obstante, considerando que la anchura de las hojas proyectadas disminuye 

considerablemente a medida que estas se sitúan hacia el sur, en caso de considerarse 

conveniente por razones de optimización de la producción o la representación, podrán 

establecerse algunas excepciones ampliando más la extensión en longitud de las hojas. 

Este es al caso aplicado por ejemplo a las hojas 5369-I / 5969-II y 5369-IV / 5366-III, situadas 

en el extremo meridional para las que se propone elaborar sendas unidades cartografía y 

edición con una extensión de 1° 90´ en longitud. 

2.3.2 NOMENCLATURA DE LAS HOJAS EXTENDIDAS. 

La nomenclatura (característica de la hoja) de las hojas 1:250.000 extendidas está formada 

por la nomenclatura de la hoja principal, la de mayor superficie, seguida de un espacio y la 

nomenclatura de la hoja añadida entre paréntesis. Se contemplan dos supuestos (Figura 8): 

0020’

EXTENSIÓN

GRILLA 1:100.000 

MARCO  ORIGINAL 
DE LA HOJA 1:250.000 

MARCO  ORIGINAL 
DE LA HOJA 1:250.000 

GRILLA 1:100.000 

EXTENSIÓN
0030’
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Supuesto 1: en el caso de que las extensiones se realicen sobre un cuarto de la misma 

hoja 1:500.000 a la que pertenece la principal, tan sólo se añadirá el número 

romano que lo identifica separado por una barra inclinada. 

Supuesto 2: en el caso de que las extensiones se realicen sobre la superficie de una hoja 

1:500.000 diferente a la de la principal se deberá incluir la nomenclatura completa 

de la hoja añadida, separada por una barra inclinada. 

 

 
Supuesto 1 Supuesto 2 

Figura 8. Interpretación de la nomenclatura de las  hojas 1:250.000 extendidas. 

HOJA PRINCIPAL

HOJA AÑADIDA
5566-III

5566-I

5566-I / III

Nomenclatura
hoja 1:500.000

Cuarto hoja 
1:250.000

Cuarto hoja 
añadido

HOJA PRINCIPAL

HOJA AÑADIDA
2954-I

2754-III

2754-III / 2954-I

Nomenclatura
hoja 1:500.000

Cuarto hoja 
1:250.000

Nomenclatura de
la hoja añadida
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2.4 DISTRIBUCIÓN DE LAS HOJAS DE LA CARTA GEOLÓGICA 1:250.000. 

Considerando las anteriores determinaciones la distribución inicial de la Carta Geológica 

1:250.000 constaría de 224 hojas (Figura 9), de las que 28 serían extendidas (Tabla 3). 

 

 
Figura 9. Distribución de las hojas de la Carta Geológica 1:250.000. 
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Tabla 3. Hojas extendidas de la Carta Geológica 1:250.000. 

HOJA EXTENDIDA HOJA PRINCIPAL 

NÚMERO NOMBRE NÚMERO NOMBRE 

2166-IV / 2366-II LA QUIACA 2366-II LA QUIACA 
2366-I / 2166-III MINA PIRQUITAS 2366-I MINA PIRQUITAS 

2554-III / IV CATARATAS DEL IGUAZU 2554-III CATARATAS DEL IGUAZU 
2754-II / IV BERNARDO DE IRIGOYEN  (OBERA - APENDICE) 2754-II BERNARDO DE IRIGOYEN 
2754-III / 2954-I OBERA (SANTO TOME - APENDICE) 2754-III OBERA 

2769-IV / III FIAMBALA 2769-IV FIAMBALA 
3169-III / 3172-IV BARREAL 3169-III BARREAL 
3357-III / 3360-IV GUALEGUAYCHU 3360-IV GUALEGUAYCHU 

3360-II / 3357-I NOGOYA (CONCEPCION DEL URUGUAY) 3360-II NOGOYA 
3569-III / 3572-IV MALARGUE 3569-III MALARGUE 
3757-I / II DOLORES (MAR DE AJO) 3757-I DOLORES 

3757-III / IV BALCARCE 3757-III BALCARCE 
3960-I TRES ARROYOS 3960-I TRES ARROYOS 
4163-I / III GENERAL CONESA 4163-I GENERAL CONESA 

4163-II / IV VIEDMA 4163-II VIEDMA 
4366-IV RAWSON 4366-IV RAWSON 
4372-II / I ESQUEL 4372-II ESQUEL 

4372-IV / III TREVELIN 4372-IV TREVELIN 
4566-II CAMARONES 4566-II CAMARONES 
4572-II / I GOBERNADOR COSTA 4572-II GOBERNADOR COSTA 

4766-III / IV PUERTO DESEADO 4766-III PUERTO DESEADO 
4966-I / II BAHÍA LAURA 4966-I BAHÍA LAURA 
4972-III / 4975-IV LAGO VIEDMA 4972-III LAGO VIEDMA 

5157-III / 5357-I PUERTO ARGENTINO (BAHIA DE LOS ABRIGOS - APENDICE) 5157-III PUERTO ARGENTINO 
5172-I / 5175-II EL CALAFATE 5172-I EL CALAFATE 
5369-I / II MONTE AYMOND (MONTE DINERO) 5369-I MONTE AYMOND 

5369-IV / 5366-III RÍO GRANDE 5369-IV RÍO GRANDE 
5566-I / III TOLHUIN 5566-I TOLHUIN 
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3 ESPECIFICACIONES DEL MODELO DE COMPOSICIÓN DE HOJA. 

3.1 JUSTIFICACIÓN Y OBJETIVOS DEL MODELO DE COMPOSICIÓN DE HOJA 

La hoja cartográfica es la unidad básica de producción y comunicación de la Carta Geológica 

1:250.000. En la hoja el mapa geológico tiene un protagonismo especial pera además incluye 

otros elementos (representaciones, textos, gráficos, imágenes, esquemas) que 

complementan y ayudan a interpretar la información geológica representada. 

Con independencia de los medios técnicos que se empleen, la normalización de la 

composición cartográfica de las hojas tiene con fin último la obtención de un producto 

homogéneo que, además de facilitar al usuario final la interpretación de la información 

geográfica, posibilitan la automatización de los procesos y simplifican el control de calidad. 

Para conseguir un producto homogéneo en apariencia y calidad es necesario establecer, con 

la máxima precisión, posible unas normas sobre la composición de la hoja que proporciones a 

los autores las reglas y directrices necesarias para la elaboración de las hojas geológicas. 

En este apartado se describe el modelo de composición de hoja en el que se establecen una 

serie de normas para la edición del mapa en su conjunto y para cada uno de los elementos 

que lo componen, facilitando la lectura de las unidades geográficas representadas. 

La creación del modelo de composición de hoja tiene como principales objetivos presentar 

hojas de fácil lectura y comprensión y establecer una nomenclatura y una representación 

uniforme. 

3.2 FORMATO Y COMPOSICIÓN DE LAS HOJAS. 

En general, el formato de las hojas rectangular y apaisado (dimensión horizontal de la página 

mayor que la vertical). 
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El marco exterior de la hoja estará formado por un rectángulo situado a 10 mm de los bordes 

exteriores del papel (margen exterior). 

Asimismo, se establece un margen interior otros de otros 10 mm al marco exterior de la hoja 

que deberá quedar libre de cualquier elemento gráfico. 

El resto del espacio disponible en la página de la página constituye la caja o área de 

composición en la que se distribuirán los elementos de información de la hoja (Figura 10). 

 

 

Figura 10. Margen exterior e interior de la página. 
1. Borde de la página; 2. Margen exterior; 3. Marco exterior de la hoja; 4. Margen interior; 

 5. Área de composición. 

El tamaño máximo de las hojas será de 1350 mm x 897 mm, incluidos los márgenes exteriores. 

No obstante, el tamaño de las hojas será variable en función de las dimensiones del cuadro 

del mapa geológico a la escala de representación en la proyección Gauss-Krüger, cuyas 

dimensiones cambian en función de la latitud a la que se sitúe la hoja representada. 

En el ANEXO que acompaña a este documento se recogen los tamaños orientativos de las 

páginas de cada hoja. 

Para estructurar la información incluida en la hoja y lograr una distribución de elementos 

equilibrada, en la composición de la hoja se diferencian tres bloques (izquierdo, central y 

1
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derecho) organizados en secciones (Tabla 4; Figura 11).  La separación horizontal entre los 

bloques 1 y 2 será de al menos 10 mm y de 20 mm entre el 2 y el 3. 

 

 

 

Tabla 4. Bloques y secciones del modelo de hoja de la Carta Geológica 1:250.000. 

COLUMNA SECCIONES 

Bloque 1 (izquierda) 

1A. Cuadro estratigráfico. 
1B. Referencias geológicas. 
1C. Referencias cartográficas. 
1D. Fuentes de información. 
1E. Esquemas de ubicación. 

Bloque 2 (central) 

2A. Cabecera. 
2B. Mapa geológico. 
2C. Información técnica cartográfica. 
2D. Perfiles transversales. 

Bloque 3 (derecha) 
3A. Esquema regional. 
3B. Esquema auxiliar (tectónico o geomorfológico) 
3C. Perfiles columnares. 
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Figura 11. Distribución de los bloques y secciones del modelo de hoja  
de la Carta Geológica 1:250.000. 

Bloque 1 (izquierda): 1A. Cuadro lito-estratigráfico; 1B. Referencias geológicas; 1C. Referencias cartográficas; 1D. Fuentes de 
información; 1E. Esquemas de ubicación. 

Bloque 2 (central): 2A. Cabecera; 2B. Mapa geológico; 2C. Información técnica cartográfica; 2D. Perfiles transversales. 
Bloque 3 (derecha): 3A. Esquema regional; 3B. Esquema auxiliar (tectónico o geomorfológico); 3C. Perfiles columnares. 

  

1 2 3
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3.3 DISTRIBUCIÓN DE LOS ELEMENTOS. 

3.3.1 ELEMENTOS DEL BLOQUE 1. 

El bloque 1 ocupará la parte izquierda de la hoja y está compuesto por seis secciones 

dispuestas en orden descendente de la siguiente forma: 

1A. Cuadro lito-estratigráfico. 

1B. Referencias geológicas. 

1C. Referencias cartográficas. 

1D. Fuentes de información. 

1E. Esquemas de ubicación. 

 

 

Figura 12. Distribución de las secciones del bloque 1 del modelo de hoja  
de la Carta Geológica 1:250.000. 

 

La anchura total del bloque 1 será de 258 mm, excluidos los espacios establecidos para el 

margen interior y la separación horizontal entre bloques.  
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La separación vertical entre las secciones 1A y 1B será como mínimo de 15 mm, dependiendo 

de la altura de los elementos del cuadro lito-estratigráfico. La separación vertical entre el resto 

de las secciones de este bloque será de 10 mm. 

3.3.1.1 Sección 1A. Cuadro lito-estratigráfico. 

El cuadro lito-estratigráfico, o leyenda principal del mapa geológico, está compuesto por dos 

columnas: 

Cuadro estratigráfico: compuesto a vez por dos columnas: 

Crono-estratigráfica: columna en la que se representa la edad de todas las unidades 

lito-estratigráficas diferenciadas (formación, grupo, complejo, etc.), 

representadas en el mapa. La columna crono-estratigráfica presentará las 

diferentes categorías de tramos diferenciables ordenadas de izquierda a 

derecha de mayor a menor amplitud temporal. 

Lito-estratigráfica: en la que se representan las relaciones estratigráficas existentes 

entre las diferentes unidades reconocidas, mediante la utilización de los 

colores, rastras y tipos de contactos geológicos aplicados en el mapa 

Descripción litológica: descripciones, en forma de texto, de las unidades lito-

estratigráficas. 

3.3.1.1.1 Cuadro estratigráfico. 

Para la elaboración de los diferentes elementos del cuadro estratigráfico se deberán observar 

las determinaciones establecidas en la normativa para el sistema de producción de cartas 

geológicas (SEGEMAR 2000, 2000b). 

Conforme a la normativa de producción, el módulo de unidad para las columnas crono y lito–

estratigráfica es de 50 x 7 mm. Ambas columnas deberán aparecer como un bloque único, sin 

espacios libres entre ambas, situándose a la izquierda la crono-estratigráfica y a la derecha 

lito-estratigráfica. La anchura total de ambas columnas será de 100 mm. 
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Figura 13. Posición en la hoja y distribución de los elementos de  
la sección 1A. Cuadro lito-estratigráfico. 

(Dimensiones en mm) 

En hojas cuya extensión abarque dos o más provincias geológicas puede resultar conveniente 

construir bloques de referencias independientes, en cuyo caso, cada uno de ellos irá 

acompañado de un rótulo indicativo de la provincia que corresponda. Rótulos de provincia 

ocuparan un rectángulo de 50 x 7 mm sobre el bloque de referencias correspondiente. 

Técnicamente el cuadro estratigráfico no es un mapa en el sentido tradicional si no un dibujo 

digitalizado en coordenadas de tablero, sobre los bosquejos presentados por el autor de la 



 

PAG. 31 DE 73  FECHA: 07/03/17 

hoja. Por tanto, se incorporará al layout como una imagen gráfica (PICTURE_ELEMENT), en 

formato EMF2 (Enhanced Metafile) con una resolución mínima de 300 dpi3. 

Para que no se incremente de forma desmedida el tamaño de los archivos MXD, las imágenes 

no se guardarán como parte del documento MXD, si no que se vinculará el archivo EMF 

(Insert > Picture) desde la ubicación determinada para los perfiles de la hoja. 

Se recomienda que el tratamiento previo a la inserción del cuadro estratigráfico se realice en 

un MXD diferente al de producción de la hoja. El archivo EMF se obtendrá a partir de la Layuot 

view mediante la herramienta de exportación del mapa de ArcMap (File>Export Map). Como 

opciones generales de exportación se establecerán las siguientes: 

Resolution: 300 dpi;  

Output Image Quality: Best;  

Clip Output to Graphics Extent: activado. 

Como norma general, el cuadro lito-estratigráfico se situará en el margen izquierdo superior 

de la hoja, alineado con el borde superior del marco del mapa geológico. 

Por encima de esta línea, con una separación 5 mm del borde superior de las columnas y 

centrado con las mimas, se situará el rótulo de la sección con el texto en mayúsculas 

“CUADRO ESTRATIGRÁFICO” con tipo arial de 14 pto. 

En casos excepcionales en los que no haya espacio suficiente se podrán ajustar el rótulo al 

límite superior de la caja en la que se encuadra la cabecera (Figura 13). También podrán 

realizarse excepciones en aquellos casos en los que la longitud del texto de las descripciones 

litológicas impida aplicar la norma general. 

                                                      
2 El formato EMF es un metaformato gráfico con profundidad de color de 32 bits, color verdadero, que puede 
contener información vectorial y mapas de bits. Es reconocido por casi todas las aplicaciones de diseño gráfico y 
compatible con los sistemas operativos Windows. Las exportaciones a EMF dan como resultado archivos 
relativamente pequeños y genéricos, compatibles con todas las impresoras. Admite curvas de Bezier. No 
redondea los extremos de las líneas rectas y En este formato las unidades son siempre milésimas de centímetro, 
1 unidad = 0.001 cm., por lo que no existe discrepancia entre distintas aplicaciones. 
3 Dots Per Inch: Puntos por pulgadas. 
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3.3.1.1.2 Descripción litológica. 

La descripción litológica se situará a la derecha del bloque de columnas crono y lito–

estratigráfica separados del mismo por un espacio de 10 mm. La anchura máxima de la 

columna de descripciones litológicas será de 148 mm, debiendo respetarse una distancia 

mínima de 10 mm respecto al marco del mapa geológico situado a la derecha (bloque 2). 

La altura de la columna de descripciones podrá variar en función del número de elementos 

identificados en la columna lito–estratigráfica. No obstante, la parte superior de la columna 

de texto deberá estar alineada con el de las columnas crono y lito–estratigráfica. Se procurará 

que la parte inferior de la columna de descripciones litológicas no supere el límite inferior de 

las columnas crono y lito–estratigráfica, si bien en este aspecto se contempla cierta flexibilidad 

ante la diversidad de situaciones. 

Las descripciones litológicas se insertarán en el layout como objeto OLE (OLEframe) vinculado 

(Insert > Object) creado desde un archivo RTF4 (Rich Text Format) en el que se incluirán los 

textos con formato de las descripciones, desde la ubicación determinada para los textos de la 

hoja. La vinculación permitirá la edición del documento de texto, a través de la aplicación 

predeterminada de Windows, y la actualización del contenido en el layout. 

El formato del texto de las descripciones litológicas contenidas en el archivo RTF se realizara 

mediante un editor de texto, en una única página con una anchura de línea de 14.8 cm y la 

altura que corresponda según la extensión del texto, conforme a los siguientes parámetros 

(Figura 14): 

Alineación: izquierda. 

Interlineado: sencillo. 

Espaciado: posterior al párrafo de 1 pto. 

Sangrías: 

Párrafo con sangría francesa de 1.5 cm, salvo para los nombres de las regiones 

que deberán quedar alineados al borde izquierdo de la página. 

Tabulación de 1.5 cm entre los códigos o siglas y las descripciones. 

Otras sangrías y tabulaciones en módulos de 1 cm. 

                                                      
4 formato de texto enriquecido 
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Tipografía:  

Códigos o siglas: arial narrow negrita de 9 pto. 

Descripciones: arial narrow normal de 9 pto. 

Nombres de las regiones geológicas y de los grupos: arial narrow negrita de 9 

pto. 

 

 

Figura 14. Formato de los textos de las descripciones litológicas. 
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Figura 15. Posición en la hoja y distribución de las secciones 1B, 1C, 1D Y 1E. 
(Dimensiones en mm) 
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3.3.1.2 Sección 1B. Referencias geológicas. 

Los símbolos cartográficos correspondientes a la geología de la hoja, o referencias geológicas, 

aparecerán en un recuadro independiente situado debajo de las referencias estratigráficas. 

Las referencias geológicas se insertarán en el layout como objeto de tipo leyenda 

(LEGEND_ELEMENT). Todos los elementos de esta sección aparecerán enmarcados con un 

rectángulo exterior, sin relleno y con un grosor de línea de 0.2 mm (Figura 16). 

 

 

Figura 16. Dimensiones de las referencias geológicas. 
(Dimensiones en mm) 

 

La anchura máxima del recuadro exterior será de 176 mm. La altura será variable en función 

del número de referencias incluidas en la leyenda. El extremo superior izquierdo del recuadro 

deberá situarse a 60 mm a la derecha del marco exterior de la hoja y, como mínimo, a 15 mm 

de cualquier elemento del cuadro estratigráfico. 

En general, los elementos aparecerán distribuidos en dos columnas conforme a las 

dimensiones establecidas en la Figura 16.  

ENCABEZADO 1

Descripción de la ref erencia geológica 1.1… 

REFERENCIAS GEOLOGICAS

ENCABEZADO 2

INDICIO Y/O YACIMIENTO MINERAL AFLORANTE

min: mineralmin

n n: número

ENCABEZADO 3

Descripción de la ref erencia geológica 1.2… 

Descripción de la ref erencia geológica 1.3… 

Descripción de la ref erencia geológica 1.4… 

Descripción de la ref erencia geológica 1.5… 

Descripción de la ref erencia geológica 1.6… 

Descripción de la ref erencia geológica 2.1… 

Descripción de la ref erencia geológica 2.2… 

Descripción de la ref erencia geológica 2.3… 

Descripción de la ref erencia geológica 2.4… 

Descripción de la ref erencia geológica 2.5… 

Descripción de la ref erencia geológica 2.6… 

Descripción de la ref erencia geológica 3.1… 

Descripción de la ref erencia geológica 3.2… 
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Por debajo de la línea superior del recuadro, con una separación 7 mm, centrado 

horizontalmente, se situará el rótulo de la sección con el texto en mayúsculas “REFERENCIAS 

GEOLÓGICAS” con tipo arial de 10 pto. y mayúsculas. 

Los textos de los encabezados de la leyenda aparecerán centrados sobre la columna 

correspondiente en mayúsculas con un tipo arial de 8 pto. 

Los símbolos lineales y puntuales representados se situarán en el centro del área disponible 

(patch shape). 

Los textos de las descripciones aparecerán alineados a la izquierda y centradas verticalmente 

con respecto al correspondiente patch shape, con un tipo arial de 7 pto. 

Se recomienda que las referencias geológicas se adapten en la medida de lo posible al modelo 

descrito en este apartado, no obstante, dada la potencial diversidad de situaciones es posible 

que sea necesario realizar algunas adaptaciones a este modelo de formato pudiendo llegar, 

en casos excepcionales, a su edición como elemento gráfico del layout para la versión final de 

impresión de la hoja. 

3.3.1.3 Sección 1C. Referencias topográficas. 

Los símbolos correspondientes a la topografía de la hoja, o referencias topográficas, 

aparecerán en un recuadro independiente situado debajo de las debajo de las referencias 

geológicas. 

Las referencias topográficas se insertarán en el layout como objeto de tipo leyenda 

(LEGEND_ELEMENT). Todos los elementos de esta sección aparecerán enmarcados con un 

rectángulo exterior, sin relleno y con un grosor de línea de 0.2 mm. 
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Figura 17. Dimensiones de las referencias topográficas. 
(Dimensiones en mm) 

La anchura máxima del recuadro exterior será de 176 mm con una alineación horizontal 

centrada respecto a las referencias del mapa principal. Inicialmente este recuadro estará 

alineado a la parte inferior del cuadro del mapa principal (Sección 2B). La altura será variable 

en función del número de referencias incluidas en la leyenda. 

En el interior se distribuirán los distintos elementos temáticamente (altimetría, Planimetría, 

hidrografía y abreviaturas) tal y como se describe en la Figura 16. 

Por debajo de la línea superior del recuadro, con una separación 7 mm, centrado 

horizontalmente, se situará el rótulo de la sección con el texto en mayúsculas “REFERENCIAS 

TOPOGRÁFICAS” con tipo arial en mayúsculas de 10 pto.  

Debajo del rótulo se insertarán el título de cada apartado seguido de los símbolos y las 

descripciones. El título de cada apartado aparecerá centrado horizontalmente, en tipo arial 

en mayúsculas de 8 pto. 

Descripción de la referencia topográfica 1.1......
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Txt10.. Descripción Txt10…........
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Los símbolos lineales y puntuales representados se situarán en el centro del área disponible 

(patch shape). Los textos de las descripciones aparecerán alineados a la izquierda y centradas 

verticalmente con respecto al correspondiente patch shape, con un tipo arial de 7 pto. 

En la parte inferior del recuadro se insertará el apartado de “ABREVIATURAS” cuadro cuyo con 

el rótulo correspondiente, centrado horizontalmente, en tipo arial de 8 pto mayúsculas. El 

listado de abreviaturas se dispondrá en cuatro columnas con un tipo arial de 6 pto. 

Se recomienda que las referencias topográficas se adapten en la medida de lo posible al 

modelo descrito en este apartado, no obstante, dada la potencial diversidad de situaciones es 

posible que sea necesario realizar algunas adaptaciones a este modelo de formato pudiendo 

llegar, en casos excepcionales, a su edición como elemento gráfico del layout para la versión 

final de impresión de la hoja. 

3.3.1.4 Sección 1D. Fuentes de información. 

Debajo de las referencias cartográficas se incluirán las fuentes de información de cartografía 

geológica que se hayan utilizado para la composición del mapa geológico definitivo. La sección 

estará compuesta por los siguientes elementos: 

Diagrama: representación simplificada de las áreas del territorio, identificadas con un 

número correlativo, en las que la información de cartografía geológica previa si ha 

servido directa, o casi directamente, para la elaboración del mapa. 

Fuentes de información: textos explicativos de los números del diagrama en los que se 

consignará el autor, título y fecha del trabajo, y escala del mapa publicado (o 

inédito, en su caso), utilizado como fuente de información cartográfica. 

Edición digital: autoría y fecha de la edición digital del mapa. 

La anchura máxima de la sección, incluyendo el esquema y los textos explicativos, será de 176 

mm y la altura de 45 mm (Figura 18). El extremo superior izquierdo del recuadro deberá 

situarse a 60 mm a la derecha del marco exterior de la hoja y, como mínimo, a 10 mm del 

recuadro de las referencias cartográficas. 
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Figura 18. Dimensiones de la sección 1D Fuentes de información. 
(Dimensiones en mm) 

 

El diagrama tendrá una dimensión de 45 mm de alto y una anchura variable en función de las 

dimensiones de la hoja a representar. Al tratarse de un dibujo o croquis, se incorporará al 

layout como una imagen gráfica (PICTURE_ELEMENT), en formato EMF (Enhanced Metafile) 

con una resolución mínima de 300 dpi. 

Para que no se incremente de forma desmedida el tamaño de los archivos MXD las imágenes 

no se guardarán como parte del documento MXD, si no que se vinculará el archivo EMF 

(Insert > Picture) desde la ubicación determinada para las imágenes de la hoja. 

Se recomienda que el tratamiento previo a la inserción del cuadro de fuentes de información 

se realice en un MXD diferente al de producción de la hoja. El archivo EMF se obtendrá a partir 

de la Layuot view mediante la herramienta de exportación del mapa de ArcMap (File>Export 

Map). Como opciones generales de exportación se establecerán las siguientes: 

Resolution: 300 dpi;  

Output Image Quality: Best;  

Clip Output to Graphics Extent: activado. 

Los textos de las fuentes de información y de la edición digital se situarán a la derecha del 

diagrama separados del mismo por un espacio de 10 mm. La altura del bloque de texto será 

de 45 mm mientras que la anchura será variable en función del tamaño del diagrama. 

Fuentes de información:
1. Fuente de información 1 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. año.
2. Fuente de información 2 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. año.
3. Fuente de información 3 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. año.
4. Fuente de información 4 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. año.
5. Fuente de información 5 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 

xxxxxxxxxxxxxxxxxxx. año.
6. Fuente de información 6 xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx. año.

Edición digital
Texto de la autoría de la edición digital(año).

2,3,4

2,3,5

3

3

2

1

2,3

Variable

45

10 Variable

176
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El bloque de textos de se insertará en el layout como objeto OLE (OLEframe) vinculado (Insert 

> Object) creado desde un archivo RTF en el que se incluirán los textos con formato (Figura 

18). 

 

 

Figura 19. Formato de los textos de las fuentes de información. 

 

El formato del texto de las fuentes contenidas en el archivo RTF se realizara mediante un editor 

de texto, en una única página con la anchura de línea igual al espacio disponible y la altura de 

45 mm, conforme a los siguientes parámetros (Figura 19): 

Tipografía:  

Títulos (Fuentes de información: / Edición digital:): arial normal de 9 pts 

Resto de los textos: arial normal de 8 pts 

Alineación: izquierda. 

Interlineado: sencillo. 

Espaciado:  

Título “Fuentes de información”: posterior de 3 pto. 

Título “Edición digital”: anterior y posterior de 3 pto. 

Sangrías: 

Para los títulos ninguna. 

Resto de los textos: izquierda 0.5 cm con sangría francesa de 0.25 cm, salvo 

para los nombres de las regiones que deberán quedar alineados al borde 

izquierdo de la página. 
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3.3.1.5 Sección 1E. Esquemas de ubicación. 

Debajo de las fuentes topográficas se indicará la situación de la hoja en la República Argentina, 

su posición relativa con respecto a las hojas vecinas y algunos datos cartográficos de interés. 

Los diferentes elementos de los esquemas de ubicación aparecerán enmarcados con un 

rectángulo exterior, sin relleno y con un grosor de línea de 0.2 mm. 

El tamaño del recuadro exterior de la sección será de 176 mm de ancho por 143 mm de alto. 

El extremo inferior izquierdo del recuadro deberá situarse a 22 mm a la derecha y a 10 mm 

por encima del marco exterior de la hoja (Figura 15). 

 

 

Figura 20. Dimensiones y distribución de los elementos de la sección 1D. Esquemas de ubicación. 
(Dimensiones en mm) 

En el interior se distribuirán los distintos elementos de la siguiente forma (Figura 20): 
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Ubicación geográfica, indicando la situación e la hoja la situación de la misma en la 

República Argentina en la parte izquierda. 

Diagrama de localización, representando su posición relativa con respecto a las 

Hojas vecinas en la parte superior derecha. 

Datos cartográficos de interés en formato texto en la parte inferior derecha. 

3.3.1.5.1  Ubicación geográfica. 

La ubicación geográfica se representará mediante el mapa bicontinental de la República 

Argentina, el cual muestra la Antártida Argentina en su real proporción con relación al sector 

continental e insular, conforme a que le sean de aplicación. El mapa incluirá la representación 

de los límites políticos y administrativos incluyendo los del mar territorial y zona económica 

exclusiva. 

El mapa bicontinental se incorporará al layout como un marco de datos 

(DATAFRAME_ELEMENT) en la posición señalada en la Figura 20 con unas dimensiones de 82 

x 120 mm, lo que equivale a una escala de 1:73.500.000, quedando enmarcado con un 

recuadro de 0.2 mm situado a 5 mm del borde exterior del dataframe. 

Sobre el recuadro anterior, a una distancia de 2 mm y centrado horizontalmente, aparecerá 

el rótulo “UBICACIÓN GEOGRÁFICA” con tipo arial de 10 pto. y mayúsculas. 

Entre las características del dataframe se activará la opción de indicador de extensión (Extent 

indicator) referido al marco del mapa principal de la hoja el geológico, de forma que sobre la 

superficie representada en el mapa bicontinental se muestre la extensión de la hoja. La 

referencia aparecerá representada con la siguiente simbología: 

Línea exterior: grosor 0.4; color (RGB) 110, 110, 110. 

Relleno: color de (RGB): 255, 211, 127. 

3.3.1.5.2 Diagrama de localización. 

Mediante el diagrama de localización, se mostrará la posición relativa de la hoja con respecto 

a las vecinas, mediante un esquema en el que se representen la hoja del mapa y las ocho 

vecinas que la rodean. En la Figura 20 se establece la posición del esquema que tendrán unas 

dimensiones de 60 mm de ancho por 40 mm de alto. 
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Sobre el diagrama de localización, a una distancia de 2 mm y centrado horizontalmente, 

aparecerá el rótulo “DIAGRAMA DE LOCALIZACIÓN” con tipo arial en mayúsculas de 10 pto. 

La incorporación al layout del diagrama de localización se realizará mediante la inserción de 

un marco de datos (DATAFRAME_ELEMENT). Además de la división de hojas, el marco de 

datos incluirá la representación de los límites provinciales con la misma simbología que la 

utilizada en el mapa bicontinental. 

La escala del marco de datos se ajustará para que se visualicen los marcos de las nueve hojas 

y las coordenadas exteriores dentro del espacio disponible para la sección. El sistema de 

coordenadas del marco de datos será GCS_WGS_1984. El marco del mapa principal, se 

representará mediante una línea de grosor 1 pto., color rojo (RGB 255, 0, 0) y sin relleno. 

En cualquier caso, la representación de las hojas deberá ir acompañada de las 

correspondientes etiquetas, indicado el número sobre el nombre de cada hoja, utilizando para 

ello una un tipo arial narrow, en mayúsculas, tamaño de 5 ptos. y color negro. 

El esquema de localización deberá incorporar en los bordes superior e izquierdo del margen 

exterior las coordenadas (grados y minutos) de latitud y longitud, respectivamente, de la 

división de las hojas, utilizando para ello una un tipo arial narrow en mayúsculas de 3.5 ptos. 

y color azul (RGB 0,92,230). 

En el caso de que la hoja del mapa se encuentre situada en uno de los extremos de la grilla de 

la carta 1:250.000 el diagrama deberá mantener esta en el centro de la representación 

añadiendo sólo las hojas circundantes por los bordes que correspondan (Figura 20) y dejando 

el resto del espacio en blanco. 

 

A  B  C 

Figura 21. Ejemplos de diagramas de localización. 
A Diagrama completo. B Diagrama de hoja situada en el borde oeste de la grilla.  

C Diagrama de hoja situada en el borde norte de la grilla 
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3.3.1.5.3  Datos cartográficos. 

El resto del espacio disponible en la sección se utilizará para la incorporación de datos 

cartográficos de interés, tales como el datum altimétrico, sistema geodésico de referencia u 

origen de la información topográfica. 

Estos datos se incorporarán en el layout, centrados verticalmente en espacio libre y 

horizontalmente con el diagrama de localización, como objeto OLE (OLEframe) vinculado 

(Insert > Object) creado desde un archivo RTF5 (Rich Text Format) en el que se incluirán los 

textos con formato, desde la ubicación determinada para los textos de la hoja. La vinculación 

permitirá la edición del documento de texto, a través de la aplicación predeterminada de 

Windows, y la actualización del contenido en el layout. 

El formato del texto contenido en el archivo RTF se realizara mediante un editor de texto, en 

una única página con una anchura de línea de 6.8 cm y la altura que corresponda según la 

extensión del texto, conforme a los siguientes parámetros (Figura 20): 

Alineación: centrada. 

Interlineado: sencillo. 

Tipografía: arial narrow normal de 9 pto 

Si se considera necesario añadir otro de tipo de información adicional, como la referida por 

ejemplo al mapa bicontinental, se recomienda utilizar el mismo método, situando el 

contenido en la parte inferior de este espacio alineado a la izquierda y con una tipografía 

diferente y de menor tamaño (por ejemplo: times new roman normal de 7 pto).  

                                                      
5 formato de texto enriquecido 
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3.3.2 ELEMENTOS DEL BLOQUE 2. 

El bloque 2 ocupará la parte central de la hoja y está compuesto por cuatro secciones 

dispuestas en orden descendente de la siguiente forma: 

2A. Cabecera. 

2B. Mapa geológico. 

2C. Información técnica cartográfica. 

2D. Perfiles transversales. 

 

 

Figura 22. Distribución de las secciones del bloque 2 del modelo de hoja  
de la Carta Geológica 1:250.000. 

 

La anchura total del bloque 2 variará en función de la anchura que requiera la representación 

de la hoja del mapa geológico proyectado. 

La separación vertical entre las secciones 2A, 2B y 2C será de 5 mm. La separación vertical 

mínima entre las secciones 2C y 2D será de 15 mm. 
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3.3.2.1 Sección 2A. Cabecera 

En la cabecera de la hoja figurarán los logotipos y anagramas del SEGEMAR e instituciones de 

las que depende, la serie y el título del mapa y el nombre de la hoja, seguido por los números 

que correspondan a las numeraciones establecidas por el IGN. 

 

 

Figura 23. Distribución de los elementos de la sección 2A del modelo de hoja  
de la Carta Geológica 1:250.000. 

 

 

El logotipo estará alineado con el recuadro externo de la hoja y a su derecha se situarán los 

nombres de las Instituciones que estarán alineados a la izquierda tal y como se ilustra en la 

Figura 24.  

El logotipo se insertará en el layout como una imagen gráfica (PICTURE_ELEMENT). 

La identificación de la serie se ubicará en la parte superior centrada con el marco del mapa 

geológico. La identificación de la serie se realizará mediante la incorporación al layout de 

elementos de texto con el nombre “CARTA GEOLÓGICA DE LA REPÚBLICA ARGENTINA”, con 

tipo arial en mayúsculas y tamaño de 22 pto. y la escala “1:250 000”, con tipo arial de 18 pto. 
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Figura 24. Detalles de la distribución de los elementos de la sección 2A del modelo de hoja  
de la Carta Geológica 1:250.000. 

(Dimensiones en mm) 

La identificación de la hoja, situada en la parte superior derecha, constará del nombre y el 

número encuadrados en sendos marcos juntos, con un grosor de 0.2 mm. Para ello se 

incorporarán sendos textos al layout con tipo times new roman negrita en mayúsculas y 

tamaño de 25 pto. 

Tanto el nombre como el número de la hoja se insertarán en el layout como como elementos 

de texto (PARAGRPH_TEXT_ELEMENT) con un contorno de 0.2 mm. 
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Sobre la identificación de la hoja se podrán situar los textos de los nombres de las provincias 

(TEXT_ELEMENT) con tipo arial en mayúsculas y tamaño de 9 pto. 

La identificación de la hoja podrá extenderse hacia la izquierda hasta una distancia de 15 mm 

de los nombres de las instituciones (Figura 24). No obstante, este formato podrá sufrir 

modificaciones en los casos en los que en una misma carta se representen dos hojas o en las 

hojas del sur del país, cuyo ancho es sensiblemente menor, pudiendo ser necesario recurrir a 

un tamaño de fuente inferior. 

3.3.2.2 Sección 2B. Mapa geológico. 

El mapa geológico ocupara la parte central con un marco exterior, sin relleno y con un grosor 

de línea de 0.2 mm, debajo de la cabecera con una separación de 5 mm. 

El tamaño de del marco exterior será variable dependiendo de espacio requerido para la 

representación del marco de datos del mapa geológico a la escala y con la proyección 

requeridas, debiendo mantenerse un espacio libre de aproximadamente 10 mm en vertical y 

12 mm en horizontal, en el que situarán las coordenadas. 

El mapa geológico propiamente dicho se insertará en el layout como marco de datos 

(DATAFRAME_ELEMENT) estableciendo en las propiedades de ArcMap una escala de 

referencia de 1:250.000 y el sistema de coordenadas POSGAR_2007_Argentina, según la faja 

que corresponda a la hoja, y la rotación equivalente a la convergencia de la cuadrícula 

conforme a dato almacenado en el campo la capa de la grilla 1:250.000 (ver anexo). 

Asimismo, deberán activarse las opciones de corte (Clip Optión) mediante el polígono del 

marco de la hoja, seleccionando también la opción de recorte de las cuadrículas de 

coordenadas, estableciendo un grosor del borde será de 0.4 mm. El tamaño del marco de 

datos en la página coincidirá con el del marco exterior.  
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Figura 25. Posición de la sección 2B del modelo de hoja de la Carta Geológica 1:250.000. 

 

Las hojas llevarán la cuadrícula Gauss-Krüger con múltiplos de 10.000 metros en línea azul de 

0.1 milímetros. En los extremos de cada línea y fuera del mapa se indicarán las coordenadas 

de cada una ellas hasta las unidades de millar. Así, por ejemplo, la coordenada 3.530.000 se 

presentará como 3530; unidades de millón y centenas de millar serán superíndices. 

Las coordenadas geográficas se representarán mediante segmentos de 3 milímetros de 

longitud en color negro perpendiculares a los bordes de la hoja, en contacto con los mismos y 

dirigidos hacia el interior. Se representarán los múltiplos de 15’ así como en las esquinas. Las 

coordenadas del extremo superior izquierdo irán acompañadas de los textos “Oeste” y “Sur” 

respectivamente con el mismo tipo de letra. Asimismo, se marcarán con una línea gris de 

(color negro al 70%) los meridianos con valor de grados enteros. 

3.3.2.3 Sección 2C. Pie del mapa. 

Al pie del mapa geológico, en la sección 2C, aparecerán los textos y elementos gráficos 

referidos a las referencias legales (izquierda), escalas y datos cartográficos (centro) y autorías 

(derecha).  

Los elementos de la sección 2C deberán aparecer separados por una distancia vertical de al 

menos 3 mm del marco exterior del mapa geológico. 

La distribución de los elementos ocupará el ancho del marco exterior del mapa geológico y la 

altura de la sección será de 25 mm. 
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3.3.2.3.1 Referencias legales. 

A la izquierda de la sección, alineado con el marco exterior del mapa geológico aparecerán las 

referencias legales y normativas que amparan la producción cartográfica mediante la 

inserción del siguiente texto: 

La presente publicación se ajusta a la cartografía oficial, establecida  
por el Poder  Ejecutivo  Nacional,  a  través  del  IGM  - Ley 22.963.- 
Programa Nacional de Cartas Geológicas y Temáticas. 
LEY Nº. 24.224 de REORDENAMIENTO MINERO. 

 

Las referencias legales se insertarán en el layout como objeto OLE (OLEframe) vinculado 

(Insert > Object) creado desde un archivo RTF en el que se incluirán los textos con formato. La 

vinculación permitirá la edición del documento de texto, a través de la aplicación 

predeterminada de Windows, y la actualización del contenido en el layout. 

El formato del texto de las referencias legales contenidas en el archivo RTF se realizará 

mediante un editor de texto, en una única con una anchura de línea 9 cm y la altura que 

corresponda según la extensión del texto, conforme a los siguientes parámetros: 

Alineación: izquierda. 

Interlineado: sencillo. 

Tipografía: arial narrow normal de 8 pto. 

3.3.2.3.2 Escalas. 

Centrado con el marco exterior del mapa geológico aparecerán las escalas del mapa, gráfica y 

numérica, la proyección cartográfica y las equidistancias de las curvas de nivel. 

La escala numérica se insertará en el layout como texto dinámico (tipo arial negrita de 11 

pto. y alineación centrada) referido al dataframe del mapa geológico incorporando mediante 

la siguiente expresión: 

ESCALA 1:<dyn type="dataFrame" name="[NOMBRE DEL DATAFRAME]" property="scale"/> 

Dado que este valor se actualiza cada vez que cambia la escala del marco de datos permitirá 

revisar que se han establecido los parámetros de escala adecuados. 
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Figura 26. Dimensiones y distribución de los elementos de la escala. 
(Dimensiones en mm) 

La escala gráfica se ajustará a las determinaciones establecidas por el IGN para la cartografía 

1:250.000. Se expresará en unidades enteras de kilómetros, con divisiones de 5 km y llevará 

un talón de 2 cm dividido en 10 partes.  

La escala gráfica se insertará en el layout como MAPSURROUND_ELEMENT referido al 

dataframe del mapa geológico. Los grosores de las líneas serán de 0.2 mm y el texto aparecerá 

en tipo arial de 5 pto. 

Debajo de la escala gráfica aparecerán los textos (tipo arial mayúsculas de 7 pto) con la 

proyección del mapa geológico y las equidistancias de las curvas de nivel representadas. 

3.3.2.3.3 Autorías. 

A la derecha de la sección, alineado con el marco exterior del mapa geológico aparecerán las 

referencias a las autorías de la hoja encabezadas por el texto “NORMAS, DIRECCIÓN Y 

SUPERVISIÓN DEL IGRM" y debajo los nombres de los autores y cualquier otro dato 

complementario que se considere necesario incluir. En la última se indicará el año de edición 

de la hoja. 

 

NORMAS, DIRECCIÓN Y SUPERVISIÓN DEL IGRM 
JEFE DE PROYECTO: Nombre y apellidos 

GEOLOGÍA: Nombre apellido1, Nombre apellido2, 
RECURSOS MINERALES: Nombre apellido1 y Nombre apellido2 

SUPERVISOR: Nombre apellido 
PROCESAMIENTO CARTOGRÁFICO: Nombre apellido 

EDICIÓN: año 

Figura 27. Modelo de textos de las autorías. 

 

En las autorías se indicará al menos los nombres del jefe del proyecto, los autores de la 

información geológica, y los responsables de la supervisión y la edición cartográfica digital. 

5 0 5 10 15 20 25 km

ESCALA 1:250.000

PROYECCIÓN CONFORME GAUSS-KRÜGER
EQUIDISTANCIA 25 Y 50 METROS

8

7

9

MARCO EXTERIOR DEL MAPA GEOLÓGICO
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Las referencias a las autorías se insertarán en el layout como objeto OLE (OLEframe) vinculado 

(Insert > Object) creado desde un archivo RTF en el que se incluirán los textos con formato. La 

vinculación permitirá la edición del documento de texto, a través de la aplicación 

predeterminada de Windows, y la actualización del contenido en el layout. 

El formato del texto de las autorías contenidas en el archivo RTF se realizará mediante un 

editor de texto, en una única con una anchura de línea 9 cm y la altura que corresponda según 

la extensión del texto, conforme a los siguientes parámetros: 

Alineación: derecha. 

Interlineado: sencillo. 

Espaciado anterior de párrafo: 1 pto. 

Tipografía: arial narrow normal de 9 pto. 

En aquellos casos en los que sea necesario se podrá ampliar la anchura hacia la izquierda para 

reducir el número de líneas de las autorías. 

 

3.3.2.4 Sección 2D. Perfiles transversales. 

Al piE de la hoja figurarán los perfiles geológicos transversales que faciliten la comprensión 

del mapa. La escala horizontal será la misma que la del mapa. La escala vertical, en lo posible, 

será igual que la horizontal, excepto en regiones de relieve llano, donde se puede admitir el 

uso de una escala mayor. La posición de estos perfiles se indicará, en el mapa, con trazas que 

permitan identificarlos fácilmente. 

Con el objeto de no ampliar excesivamente el tamaño de las hojas editadas, se recomiendo 

limitar el número de perfiles transversales a dos por hoja. 

Técnicamente los perfiles geológicos transversales cuadro estratigráfico no son un mapa en 

el sentido tradicional si no un dibujo digitalizado en coordenadas de tablero, sobre los 

bosquejos presentados por el autor de la hoja. Por tanto, se incorporará al layout como una 

imagen gráfica (PICTURE_ELEMENT), en formato EMF con una resolución mínima de 300 dpi. 
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Para que no se incremente de forma desmedida el tamaño de los archivos MXD, las imágenes 

no se guardarán como parte del documento MXD, si no que se vinculará el archivo EMF 

(Insert > Picture) desde la ubicación determinada para los perfiles de la hoja. 

Se recomienda que el tratamiento previo a la inserción del cuadro estratigráfico se realice en 

un MXD diferente al de producción de la hoja. El archivo EMF se obtendrá a partir de la Layuot 

view mediante la herramienta de exportación del mapa de ArcMap (File>Export Map). Como 

opciones generales de exportación se establecerán las siguientes: 

Resolutión: 300 dpi;  

Output Image Quality: Best;  

Clip Output to Graphics Extent: activado. 

Los perfiles transversales se situarán en la parte inferior de la hoja, con una separación mínima 

de 10 mm con respecto al marco exterior de la hoja. Deberán aparecer centrados con el marco 

exterior del mapa geológico, pudiendo ocupar un espacio horizontal igual a la anchura de 

dicho marco. En aquellos casos en que sea imprescindible para mantener la representación a 

escala de los perfiles y siempre que se produzca interferencia con los perfiles columnares, este 

espacio se podrá ampliar hasta 2 cm por cada lado. 

Por encima de esta línea, con una separación vertical mínima 15 mm tanto de del borde 

superior del perfil como de los elementos de la sección 2C, y centrado con el marco exterior 

del mapa geológico, se situará el rótulo de la sección con el texto en mayúsculas “PERFILES 

TRANSVERSALES” con tipo arial de 14 pto. 
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3.3.3 ELEMENTOS DEL BLOQUE 3. 

El bloque 3 ocupará la parte derecha de la hoja y está compuesto por tres secciones dispuestas 

en orden descendente de la siguiente forma: 

3A. Esquema regional. 

3B. Esquema auxiliar. 

3C. Perfiles columnares. 

 

 

Figura 28. Distribución de las secciones del bloque 3 del modelo de hoja  
de la Carta Geológica 1:250.000. 

 

La anchura total del bloque 3 será de 210 mm, excluidos los espacios establecidos para el 

margen interior y la separación horizontal entre bloques. La separación vertical entre las 

secciones será como mínimo de 13 mm. 
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3.3.3.1 Sección 3A. Esquema regional. 

La sección estará compuesta por los siguientes elementos: 

Esquema regional, representación de la situación relativa de la hoja con respecto a las 

unidades morfoestructurales con las que se encuentre vinculada. 

Escala, referida al marco de datos del esquema regional. 

Referencias, símbolos cartográficos empleados en la representación. 

3.3.3.1.1 Esquema regional. 

Irá incluido en un recuadro, de 0.2 mm de grosor, cuyo borde superior derecho deberá 

situarse a 10 mm del marco exterior de la hoja. La anchura del recuadro será de 200 mm 

pudiendo ampliarse otros 10 mm por la izquierda en caso de que la representación lo requiera. 

La altura será variable dependiendo de las dimensiones de las hojas representadas. 

Entre el recuadro y el marco de datos situado en el interior deberán mantenerse las siguientes 

distancias respecto al mismo: superior 5 mm, inferior 13 mm y laterales 10 mm. 

Sobre el recuadro, a una distancia de 5 mm y centrado horizontalmente, aparecerá el rótulo 

“ESQUEMA REGIONAL” con tipo arial de 14 pto. y mayúsculas. 

El esquema incluirá la cuadrícula geográfica en línea azul de 0.1 milímetros. Para las 

longitudes el intervalo de la cuadrícula será de 1,5 grados y para las latitudes de 1 grado. En 

los extremos de cada línea, en el espacio libre entre el recuadro y el marco de datos, se 

etiquetarán las coordenadas geográficas en grados y minutos. Las coordenadas del extremo 

superior izquierdo irán acompañadas de los textos “Oeste” y “Sur” respectivamente con el 

mismo tipo de letra. 

Entre las características del dataframe se activará la opción de indicador de extensión (Extent 

indicator) referido al marco del mapa principal de la hoja el geológico, de forma que sobre la 

superficie representada en el esquema se muestre la extensión de la hoja. La referencia, que 

deberá ocupar el centro de la imagen, aparecerá representada con una línea de grosor de 0.3 

mm. La extensión del marco de datos se procurará abarcar grados completos.  
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Figura 29. Distribución de los elementos de la sección 3A del modelo de hoja  
de la Carta Geológica 1:250.000. 

(Dimensiones en mm) 

3.3.3.1.2 Escala del esquema regional. 

En la parte inferior del esquema, dentro del recuadro, con una separación 3 mm y centrada 

con el marco de datos, aparecerá la escala gráfica del mismo. Se expresará en unidades 

enteras de kilómetros, con 6 divisiones de 25 km y llevará un talón de dividido en 5 partes.  

La escala gráfica se insertará en el layout como MAPSURROUND_ELEMENT referido al 

dataframe del esquema regional. Los grosores de las líneas serán de 0.2 mm y el texto 

aparecerá en tipo arial de 5 pto. 

ESQUEMA REGIONAL

64°30' 63°00'66°00'

64°30'67°30' 63°00'66°00'

28°00'

29°00'

30°00'

31°00'

29°00'

30°00'

31°00'

REFERENCIAS

Referencia 1

Referencia 2

Referencia 3

Referencia 4

Referencia 5

25 0 25 50 75 100 125 km

ESQUEMA TECTÓNICO

Referencia 6

Referencia 7

Referencia 8

Referencia 9

Referencia 10

Referencia 11

Referencia 12

Referencia 13

Referencia 14

Referencia 15

200

101010

5

13

3
4

5

5

10 10

variable

variable

variable
20

13
M

AR
CO

 E
XT

ER
IO

R

M
AR

CO
 D

EL
 M

AP
A 

GE
O

LÓ
GI

CO

5

64°30' 63°00'66°00'

67°30' 63°00'

28°00'

29°00'

30°00'

31°00'

28°00‘  
Sur  

67°30‘ Oeste

29°00'

30°00'

31°00'

ESCALA 1:2.500.000

PROYECCIÓN CONFORME GAUSS-KRÜGER



 

PAG. 57 DE 73  FECHA: 07/03/17 

Sobre la escala gráfica su situará la escala numérica se insertará en el layout como texto 

dinámico (tipo arial de 5 pto. y alineación centrada) referido al dataframe del esquema 

regional incorporando mediante la siguiente expresión: 

ESCALA 1:<dyn type="dataFrame" name= "XXXXXXXX" property =" scale"/> 

Donde "XXXXXXXX" se refiere al nombre del marco de datos del esquema regional. Dado que 

este valor se actualiza cada vez que cambia la escala del marco de datos permitirá revisar que 

se han establecido los parámetros de escala adecuados. 

Debajo de la escala gráfica aparecerán los textos (tipo arial mayúsculas de 5 pto) con la 

proyección del esquema regional. 

3.3.3.1.3 Referencias del esquema regional. 

Las referencias se insertarán en el layout como objeto de tipo leyenda (LEGEND_ELEMENT) 

rotulado con el texto en mayúsculas “REFERENCIAS” con tipo arial de 8 pto. y mayúsculas. 

Las referencias se repartirán en dos o tres columnas, cuando se trate de unidades litológicas. 

Si además se incluyen referencias de estructuras estas podrán distribuirse hasta en cuatro 

columnas. 

El tamaño de las cajas será de 10 x 5 mm, la separación entre filas será de 5 mm y los textos 

quedarán a 2 mm del lateral derecho de las cajas. El texto de las referencias será de tipo arial 

de 7 pto. 

3.3.3.2 Sección 3B. Esquema auxiliar. 

La sección estará compuesta por los siguientes elementos: 

Esquema auxiliar, esquema tectónico o geomorfológico de la superficie de la hoja 

geológica. 

Escala, referida al marco de datos de esquema auxiliar. 

Referencias, símbolos cartográficos empleados en la representación. 

3.3.3.2.1 Esquema auxiliar. 

El esquema auxiliar se incorporará al layout como un marco de datos 

(DATAFRAME_ELEMENT), a escala 1:1.000.000, sistema de coordenadas 
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POSGAR_2007_Argentina, según la faja que corresponda a la hoja, y la rotación equivalente 

a la convergencia de la cuadrícula conforme a dato almacenado en el campo la capa de la grilla 

1:250.000 (ver anexo). El marco de datos del esquema auxiliar cubrirá la misma área que la 

hoja a escala 1:250.000 representada en el mapa geológico. 

Irá incluido en un recuadro, de 0.2 mm de grosor, cuyo borde derecho deberá alinearse con 

el marco del mapa principal. La anchura y altura del recuadro serán variables dependiendo 

de las dimensiones de la hoja representadas. Entre el recuadro y el marco de datos situado en 

el interior deberán mantenerse las siguientes distancias respecto al mismo: superior 5 mm, 

inferior 13 mm y laterales 10 mm. 

Sobre el recuadro, a una distancia de 5 mm y centrado horizontalmente, aparecerá el rótulo 

“ESQUEMA TECTÓNICO” o, en su caso, “ESQUEMA GEOMORFOLÓGICO”, con tipo arial de 14 

pto. y mayúsculas. 

Los esquemas auxiliares de las hojas a escala 1:250.000 deben llevar la grilla en coordenadas 

geográficas en color gris 70% cada 30’, etiquetándose tan solo las esquinas del mismo. 

En los 4 esquineros de la hoja deberán aparecer las coordenadas completas en grados y 

minutos con tipo de letra arial de 5 pto. Las coordenadas del extremo superior izquierdo irán 

acompañadas de los textos “Oeste” y “Sur” respectivamente con el mismo tipo de letra. 
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Figura 30. Distribución de los elementos de la sección 3B del modelo de hoja  
de la Carta Geológica 1:250.000. 

(Dimensiones en mm) 

 

3.3.3.2.2 Escala del esquema auxiliar. 

La escala gráfica se insertará en el layout como MAPSURROUND_ELEMENT referido al 

dataframe del esquema auxiliar. Los grosores de las líneas serán de 0.2 mm y el texto 

aparecerá en tipo arial de 5 pto. 
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Sobre la escala gráfica su situará la escala numérica se insertará en el layout como texto 

dinámico (tipo arial de 5 pto. y alineación centrada) referido al dataframe del esquema 

auxiliar incorporando mediante la siguiente expresión: 

ESCALA 1:<dyn type="dataFrame" name= "XXXXXXXX" property ="scale"/> 

Donde "XXXXXXXX" se refiere al nombre del marco de datos del esquema auxiliar. Dado que 

este valor se actualiza cada vez que cambia la escala del marco de datos permitirá revisar que 

se han establecido los parámetros de escala adecuados. 

Debajo de la escala gráfica aparecerán los textos (tipo arial mayúsculas de 5 pto) con la 

proyección del esquema auxiliar. 

3.3.3.2.3 Referencias del esquema auxiliar. 

Las referencias se insertarán en el layout como objeto de tipo leyenda (LEGEND_ELEMENT) 

rotulado con el texto en mayúsculas “REFERENCIAS” con tipo arial de 8 pto. y mayúsculas. 

Las referencias se repartirán en tres columnas y tamaño de las cajas será de 10 x 5 mm, la 

separación entre filas será de 5 mm y los textos quedarán a 2 mm del lateral derecho de las 

cajas. El texto de las referencias será de tipo arial de 7 pto. 

3.3.3.3 Sección 3C. Perfiles columnares. 

Debajo del esquema tectónico o geomorfológico figurarán las columnas estratigráficas 

esquemáticas que representen a las principales unidades litoestratigráficas. Los espesores de 

los distintos niveles estarán representados a escala conveniente. 

Técnicamente los perfiles columnares cuadro estratigráfico no son un mapa en el sentido 

tradicional si no un dibujo digitalizado en coordenadas de tablero, sobre los bosquejos 

presentados por el autor de la hoja. Por tanto, se incorporará al layout como una imagen 

gráfica (PICTURE_ELEMENT), en formato EMF con una resolución mínima de 300 dpi. 

Para que no se incremente de forma desmedida el tamaño de los archivos MXD, las imágenes 

no se guardarán como parte del documento MXD, si no que se vinculará el archivo EMF 

(Insert > Picture) desde la ubicación determinada para los perfiles de la hoja. 

Se recomienda que el tratamiento previo a la inserción del cuadro estratigráfico se realice en 

un MXD diferente al de producción de la hoja. El archivo EMF se obtendrá a partir de la Layuot 
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view mediante la herramienta de exportación del mapa de ArcMap (File>Export Map). Como 

opciones generales de exportación se establecerán las siguientes: 

Resolution: 300 dpi;  

Output Image Quality: Best;  

Clip Output to Graphics Extent: activado. 

Los perfiles transversales se situarán en la parte inferior derecha de la hoja, con una 

separación mínima de 10 mm con respecto al marco exterior de la hoja.  

La distribución de los perfiles podrá ocupar un espacio horizontal igual a la anchura del Bloque 

C. La altura será variable en función del espacio que ocupen los esquemas regional y tectónico 

y sus correspondientes referencias. 

Por encima de esta línea, con una separación vertical mínima 15 mm del borde superior de las 

columnas y centrado, se situará el rótulo de la sección con el texto en mayúsculas “PERFILES 

COLUNARES” con tipo arial de 14 pto. 
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4 DENOMINACIÓN Y CARACTERÍSTICAS DE LOS ELEMENTOS DE LA 
COMPOSICIÓN. 

 

 

 

MarcoExterior
Descripción Marco exterior de la  carta

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

MarcoRecorte
Descripción Marco de la  página

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

ELEMENTOS EXTERIORES

S1aCadroEstra
Descripción Cuadro estratigráfico

Tipo PICTURE_ELEMENT

Formato EMF

Fichero \Imagenes\S1aCadroEstra .emf

Anchor Point SupIzq

S1aRotulo
Descripción Rótulo de la  sección S1a

Tipo TEXT_ELEMENT

Texto CUADRO ESTRATIGRÁFICO

Tipo Aria l , 14, a l ineación i zquierda.

Anchor Point InfCen

S1aTxtLito
Descripción Descripciones  l i tológicas

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S1aTxtLi to.rtf

Anchor Point SupDer

S1a

BLOQUE 1

S1bRefGeo
Descripción Referencias  geológicas

Tipo LEGEND ELEMENT

Parent DF S2bMapaPrincipa l

Título REFERENCIAS GEOLÓGICAS

Anchor Point SupCen

S1b
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S1cRefCarto
Descripción Referencias  cartográficas

Tipo LEGEND ELEMENT

Parent DF S2bMapaPrincipa l

Título REFERENCIAS TOPOGRÁFICAS

Anchor Point InfIzq

S1cTxtAbrevia
Descripción Abreviaturas  de la  topografía

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S1cTxtAbrevia .rtf

Anchor Point SupIzq

S1c

S1dEsqFuentes
Descripción Esquemas  fuentes  cartográficas

Tipo PICTURE_ELEMENT

Formato EMF

Fichero \Imagenes\S1dEsqFuentes .emf

Anchor Point InfIzq

S1dTxtFuentes
Descripción Textos  fuentes  cartográficas

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S1dTxtFuentes .rtf

Anchor Point SupIzq

S1d
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S1eDesOeste
Descripción Coordenada Oeste del  mapa bicontinenta l

Tipo TEXT_ELEMENT

Texto Oeste

Tipo Times  New Roman, 6, a l ineación centrada.

Anchor Point InfIzq

S1eDesSur
Descripción Coordenada Sur del  mapa bicontinenta l

Tipo TEXT_ELEMENT

Texto Sur

Tipo Times  New Roman, 6, a l ineación centrada.

Anchor Point InfIzq

S1eEsqLocaliza
Descripción DF Esquema de loca l i zación

Tipo DATAFRAME_ELEMENT

Escala Ref (variable)

Anchor Point InfIzq

S1eMapaBicon
Descripción DF del  Mapa Bicontinenta l

Tipo DATAFRAME_ELEMENT

Escala Ref 1: 73500000

Anchor Point InfIzq

S1eMarcoBicon
Descripción Marco del  Mapa Bicontinenta l

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

S1eMarcoExtBicont
Descripción Marco exterior del  Mapa bicontinenta l

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

S1eRotuloLocaliza
Descripción Rótulo de los  mapas  de loca l i zación

Tipo TEXT_ELEMENT

Texto DIAGRAMA DE LOCALIZACIÓN

Tipo Aria l , 10, a l ineación centrada.

Anchor Point InfIzq

S1eRotuloUbica
Descripción Rótulo del  Mapa Bicontinenta l

Tipo TEXT_ELEMENT

Texto UBICACIÓN GEOGRÁFICA

Tipo Aria l , 10, a l ineación centrada.

Anchor Point InfIzq

S1eTxtDatum
Descripción Textos  datos  cartográficos

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S1eTxtDatum.rtf

Anchor Point SupCen

S1eTxtExplica
Descripción Textos  comentarios  cartográficos

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S1eTxtExpl ica .rtf

Anchor Point InfIzq

S1e
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S2aLogo
Descripción Logotipo SEGEMAR

Tipo PICTURE_ELEMENT

Formato JPG

Fichero \Imagenes\S2aLogoSegemar.jpg

Anchor Point InfIzq

S2aTxtNomHoja
Descripción Nombre de la  hoja

Tipo PARAGRAPH TEXT ELEMENT

Texto (variable)

Tipo
Times  New Roman, 25, Negri ta , a l ineación 
derecha.

Marco 0,2 mm

Posición text Centro / Derecha

Nº Columns 1

Margin AT 5

Anchor Point InfDer

S2aTxtNumHoja
Descripción Número de la  hoja

Tipo PARAGRAPH TEXT ELEMENT

Texto (variable)

Tipo
Times  New Roman, 25, Negri ta , a l ineación 
centrada.

Marco 0,2 mm

Posición text Centro / Centro

Nº Columns 1

Margin AT 5

Anchor Point InfDer

S2aTxtProvincias
Descripción Pronvincia/s  correspondientes  a  la  hoja

Tipo TEXT_ELEMENT

Texto PROVINCIAS

Tipo Aria l , 9, a l ineación derecha.

Anchor Point InfDer

S2aTxtTitulo
Descripción Identi ficación de la  serie cartográfica

Tipo TEXT_ELEMENT

Texto CARTA GEOLÓGICA DE LA REPÚBLICA ARGENTINA

Tipo Aria l , 22, a l ineación centrada.

Anchor Point InfCen

S2aTxtTituloEscala
Descripción Esca la  de la  serie cartográfica

Tipo TEXT_ELEMENT

Texto ESCALA 1:250 000

Tipo Aria l , 18, a l ineación centrada.

Anchor Point InfCen

S2a

BLOQUE 2
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S2bDesOeste
Descripción Coordenada Oeste del  mapa principa l

Tipo TEXT_ELEMENT

Texto S2bDesOeste

Tipo Aria l , 4, a l ineación centrada.

Anchor Point InfCen

S2bDesSur
Descripción Coordenada Sur del  mapa principa l

Tipo TEXT_ELEMENT

Texto S2bDesSur

Tipo Aria l , 4, a l ineación derecha.

Anchor Point SupDer

S2bMapaPrincipal
Descripción DF del  mapa principa l

Tipo DATAFRAME_ELEMENT

Escala Ref 1: 250000

Anchor Point InfIzq

S2bMarcoGeo
Descripción Marco del  mapa principa l

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

S2b
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S2cEscalaGrafica
Descripción Esca la  gráfica  del  mapa principa l

Tipo MAPSURROUND_ELEMENT (sca lebar)

Parent DF S2bMapaPrincipa l

Anchor Point InfCen

S2cEscalaNum
Descripción Esca la  numérica  del  mapa principa l

Tipo TEXT_ELEMENT

Texto
ESCALA 1:<dyn type="dataFrame" 
name="S2bMapaPrincipa l" property="sca le"/>

Tipo Aria l , 11, Negri ta , a l ineación centrada.

Anchor Point InfCen

S2cTxtAutores
Descripción Autorías  del  mapa principa l

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S2cTxtAutores .rtf

Anchor Point SupDer

S2cTxtLegal
Descripción Textos  referencias  normativas

Tipo OLE FRAME

Formato RTF

Fichero \Texto\Geologia\S2cTxtLegal .rtf

Anchor Point SupIzq

S2cTxtProEquidis

Descripción
Datos  proyección equidis tancia  del  mapa 
principa l

Tipo TEXT_ELEMENT

Texto
PROYECCIÓN CONFORME GAUSS-KRÜGER 
EQUIDISTANCIA 25 Y 50 METROS

Tipo Aria l , 7, a l ineación centrada.

Anchor Point InfCen

S2c

S2dPerfilesT
Descripción Perfi les  transversa les

Tipo PICTURE_ELEMENT

Formato EMF

Fichero \Imagenes\S2dPerfi lesT.emf

Anchor Point SupCen

S2dRotulo
Descripción Rótulo de la  sección S2d

Tipo TEXT_ELEMENT

Texto PERFILES TRANSVERSALES

Tipo Aria l , 14, a l ineación centrada.

Anchor Point InfCen

S2d
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S3aAuxOeste
Descripción Coordenada Oeste del  esquema S3a

Tipo TEXT_ELEMENT

Texto Oeste

Tipo Aria l , 5, a l ineación i zquierda.

Anchor Point InfIzq

S3aAuxSur
Descripción Coordenada Sur del  esquema S3a

Tipo TEXT_ELEMENT

Texto Sur

Tipo Aria l , 5, a l ineación i zquierda.

Anchor Point SupDer

S3aEscalaGrafica
Descripción Esca la  gráfica  del  esquema auxi l iar S3a

Tipo MAPSURROUND_ELEMENT (sca lebar)

Parent DF S3aEsqAuxi l iar

Anchor Point InfCen

S3aEscalaNum
Descripción Esca la  numérica  del  esquema S3a

Tipo TEXT_ELEMENT

Texto
ESCALA 1:<dyn type="dataFrame" 
name="S3aEsqAuxi l iar" property="sca le"/>

Tipo Aria l , 5, a l ineación i zquierda.

Anchor Point InfCen

S3aEsqAuxiliar
Descripción DF del  Esquema Regional

Tipo DATAFRAME_ELEMENT

Escala Ref 1: 2500000

Anchor Point InfIzq

S3aMarco
Descripción Marco de la  sección S3a

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

S3aRefAux
Descripción Referencias  del  esquema auxi l iar S3a

Tipo LEGEND ELEMENT

Parent DF S3aEsqAuxi l iar

Título REFERENCIAS

Anchor Point SupCen

S3aRotulo
Descripción Rótulo de la  sección S3a

Tipo TEXT_ELEMENT

Texto ESQUEMA REGIONAL

Tipo Aria l , 14, a l ineación centrada.

Anchor Point InfCen

S3aTxtProEquidis

Descripción
Datos  proyección equidis tancia  del  esquema 
S3a

Tipo TEXT_ELEMENT

Texto PROYECCIÓN CONFORME GAUSS-KRÜGER

Tipo Aria l , 5, a l ineación centrada.

Anchor Point InfCen

S3a

BLOQUE 3
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S3bAuxOeste
Descripción Coordenada Oeste del  esquema S3b

Tipo TEXT_ELEMENT

Texto Oeste

Tipo Aria l , 5, a l ineación i zquierda.

Anchor Point InfIzq

S3bAuxSur
Descripción Coordenada Sur del  esquema S3b

Tipo TEXT_ELEMENT

Texto Sur

Tipo Aria l , 5, a l ineación i zquierda.

Anchor Point SupDer

S3bEscalaGrafica
Descripción Esca la  gráfica  del  esquema auxi l iar S3b

Tipo MAPSURROUND_ELEMENT (Sca lebar)

Parent DF S3bEsqAuxi l iar

Anchor Point InfCen

S3bEscalaNum
Descripción Esca la  numérica  del  esquema S3b

Tipo TEXT_ELEMENT

Texto
ESCALA 1:<dyn type="dataFrame" 
name="S3bEsqAuxi l iar" property="sca le"/>

Tipo Aria l , 5, a l ineación centrada.

Anchor Point InfCen

S3bEsqAuxiliar
Descripción DF del  mapa Geológico

Tipo DATAFRAME_ELEMENT

Escala Ref 1: 1000000

Anchor Point InfIzq

S3bMarco
Descripción Marco de la  sección S3b

Tipo GRAPHIC_ELEMENT

Anchor Point InfIzq

S3bRefAux
Descripción Referencias  del  esquema auxi l iar S3b

Tipo LEGEND ELEMENT

Parent DF S3bEsqAuxi l iar

Título REFERENCIAS

Anchor Point SupCen

S3bRotulo
Descripción Rótulo de la  sección S3b

Tipo TEXT_ELEMENT

Texto ESQUEMA AUXILIAR (variable)

Tipo Aria l , 14, a l ineación centrada.

Anchor Point InfCen

S3bTxtProEquidis

Descripción Datos  proyección equidis tancia  del  esquema 
S3b

Tipo TEXT_ELEMENT

Texto PROYECCIÓN CONFORME GAUSS-KRÜGER

Tipo Aria l , 5, a l ineación centrada.

Anchor Point InfCen

S3b
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S3cPerfilesC
Descripción Perfi les  columnares

Tipo PICTURE_ELEMENT

Formato EMF

Fichero \Imagenes\S3cPerfi lesC.emf

Anchor Point SupCen

S3cRotulo
Descripción Rótulo de la  sección S3c

Tipo TEXT_ELEMENT

Texto PERFILES COLUMNARES

Tipo Aria l , 14, a l ineación centrada.

Anchor Point InfCen

S3c
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